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Recommended Browser Settings

Internet Explorer Settings (PC) | Mozilla Firefox Settings (PC) | Mozilla Firefox Settings (Mac) | Safari

Settings (Mac)

Infinite Campus recommends modifying certain browser settings for optimal use of Infinite Campus
software. Browsers should be kept current by applying service packs and updates as provided by the
operating system. Infinite Campus currently supports Internet Explorer and Mozilla Firefox browsers on a
PC platform. Mozilla Firefox, Safari and Camino browsers are supported on the Macintosh platform.

Infinite Campus cannot guarantee full support of all browsers or all versions. Please
see the Supported Platforms page for more up-to-date information on browser and
platform support.

Internet Explorer Settings (PC)

For the most recent browser versions that are supported in Campus, see the Supported Platforms article.

The names and locations of settings may vary slightly across versions (the following
were based off of IE 8 on a Windows environment).

To access the browser settings, navigate to the Tools menu and select Internet Options.

Tools | Help

DeMEe Browsing Hiskary, .. Ckrl+5hift+Del
InPM¢ate Browsing Ckrl+5Shift+P
Reofen Lask Browsing Session

Ctrl4-Shift+F

Developer Too F1z

Diagnose Con Problems. ..

Inkternet Cptions
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Image 1. Internet Explorer Tools Menu

The following settings are recommended:

General Settings

On the General tab:

General Security | Privacy | Conkent || Connections || Programs | Adwanced

[ Use current

Browsing history

Delete temporary files, history, cookies,
) and web Form information,

Setkings

Temporary Internet Files

Internet Explorer stares copies of webpages, images,
fFor Faster wigwing later,

Setkings

Check For newer versions of stored pages;
(%) Ewery time I visit the webpag
() Every time I start Inkernet Explorer Sertings
) Aukomatically

() Mever

!

Image 2. General Settings for Temporary Files (IE)

1. Click the Settings button of the Browsing History section.

2. On the Temporary Internet Files dialog box, set the Check For Newer Versions of Stored Pages
option to Every Time | Visit the Webpage.

3. Click OK.

Security Settings

On the Security tab, several settings are applicable.

Trusted Sites

Set Infinite Campus as a trusted site:
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ieneral | Security |F‘rivacy Content | Connections | Programs | &dvanced

Select a zone ko view or change security settings,

¢ € U/ o

Internet Local inkranet Trusked sites Restricted s[\"

(<] i | 2]
Trusted sites
f This zone contains websites that you

w krust nok ko damage wour compuker or

wour files,
You have websites in this zane,

Trusted sites .

Yol can add and remove websites from this zone. &l websites in
‘,r this zone will use the zone's security settings.

Add this website to the zone:
https: ftraining.infinitecampus com| |

Websites:

https: f jtraining. infinitecampus, com

[ |Reguire server verification (https:) for all sices in this zone

Close

Image 3. Security Settings for Trusted Sites

1. Select the Trusted sites icon from the "Select a zone..." box.

2. Click Sites.

3. If not automatically displayed, enter the URL address of the Campus application in the Add this
website to the zone field.

4. Click Add.

5. Verify that the address appears in the Website box.

6. If the site is not a secure site - indicated by an "https" in the URL - remove the mark from the Requ
ire server verification (https:) for all sites in this zone checkbox.

7. Click Close on the Trusted Sites window to return to the Security tab.
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Downloads

On the Security tab, configure the download settings:

Internet Options 2

General | Security |F‘rivacv || Cantent || Connections || Programs || Advanced |

- ge security setkings,

Security Settings - Internet Zone J ®H
Settings '
kranet Trusted sites Restrlcted
(%) Enabls w 11 | [ll

g it
& Downlaads rnet websites, e
,93 Aukomatic prompting For file downloads n trusted and
() Disable
(%) Enable
@;ﬁ File: download
(") Disable

(¥} Enable

T
() Disable
(& Enable ecommerfed settings, click Default level,
(::) Prampk
@ﬁ Enable .MET Framework, setup
() Disable

(3% Frshla ;
Custom lewel, .. [ Defaulk level

s, click Cuskom level,

Image 4. Security Settings for Downloads (IE)

1. Click the Custom Level button.
2. Locate the Downloads section. Enable both the Automatic Prompting for File Downloads and
the File Download options.

SmartScreen Filter

While still in the Security Settings window, turn off the SmartScreen Filter for the zone:
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Security Settings - Trusted Sites Zone

Sekkings

) Prompt
| | Use Pop-up Blocker

() Disable

| | Use SmartScreen Filker

(%) Disable
Enable

L] Izerdata persistence
() Disable
{(3) Enable

| | Websites in less privileged web conkent zone can navigate in
() Disable
() Enable
(%) Prompt

=] Seripting

= Arkive sevimkine

(<] m |

*Takes effect after wou restart Internet Explorer

Reset cuskom settings

Reset to: | Mediurm (defaulk) BI

Image 5. Miscellaneous Security Settings (IE)

1. Toward the bottom of the list, under "Miscellaneous," Disable the SmartScreen Filter.

2. Click OK.
3. On the verification window, click Yes.

Privacy Settings

On the Privacy tab:
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Pop-up Blocker Settings £

eneral | Security | Privacy | Conkent | Connections | Programs | Advanced

Exzeptionz
Pop-upsz are currently blocked. You can allow pop-ups from specific Settings
# !l websites by adding the site to the list below. [
Select a setting For the Internet zone,
Address of website to allow:
hitp: 4/ support.infintecampu. com? Add Medium
. - Blacks third-p @ty cackies that do not have a compact
Allowed sites: privacy policy
192.168.20.182 - Blocks third-p@ty cookies that save information that can
192 168.20.210 L b used to contlck you without your explicit consent
192.168,20.222 - Restricts firstfarty cookies that save information that
altima.ic.org EEEL can be used to Bontact you without your implicit consent

rnail gaogle. com
testappl.infinitecampus. con
training.infinitecampuz. com ’ Sites ][ Irnpatt ] [ advanced ]
webmail infinitecampusz. com
vy, link sy, com

Pop-up Blocker

ér Prevent most pop-up windivjii" Settings

Muotifications and blocking level: appearing.
Play & sound when a pop-up iz blocked. Turn on Pop-up Blocker

Show Information Bar when a pop-up is blocked.

TeFwis sk
—

Image 6. Privacy Settings for Pop-Ups (IE)

1. The privacy setting for the Internet zone should be set to Medium.
2. The Pop-up Blocker section should allow pop-ups to the Infinite Campus site in one of the
following manners:
® The Turn On Pop-Up Blocker checkbox is not marked (allowing all pop-ups from all sites),
OR
® The Turn On Pop-Up Blocker checkbox is marked, but the Infinite Campus website is
allowed:
® Click the Settings button.
Enter the URL of the Campus application in the Address of website to allow field.
Click Add.
Verify that the address just added now appears in the Allowed Sites list.
Click Close.

3. Click OK.

Content Settings

On the Content tab:
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General | Security || Privacy | Conkent | Connections | Programs | Adwvanced

AutoC lete Setti
U10-0mprEte Settings Content Advisor

AutoComplete lists possible matches Fram entries you've @ Ratings help you control the Inkernet conbent that can be
typed or visited before, viewed on this computer,

IJse AutoCaomplete For

Address bar

Browsing hiskary

Favariktes

[Feeds

Use Windows Search for better results
[ IForms ‘_ ButoComplete

[CJuser names and passwords on Forms *——:— e : Settings
50y onwebpages and suggests m

) for you,
Feeds and web Slices

[ Delete AutoComplete history. .. ] Feeds and Web Slices provide updated Settings
&l

Certificates

|Jse certificates For encrypted connections and identification,

[ Clear 550 state ] [ Certificates ] [ Publishers ]

content From websites that can be
read in Internet Explorer and other
[ (0] ] [ Cancel l Tt

Image 7. Content Settings for Auto-Complete (IE)

1. Click the Settings button of the AutoComplete section.

2. On the AutoComplete Setting dialog box, remove marks from the Forms and User Names and
Passwords On Forms checkboxes.

3. Click Delete AutoComplete History.

4. Click OK.

Advanced Settings

On the Advanced tab, there are several settings to configure.

Auto-Complete

Turn off auto-complete:
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Internet Options

General | Security | Privacy | Content | Connections F'ru:-grams| .ﬁ.dvanced[

Settings

Show Friendly HTTP error messages
=] underline links
& always

{:} Hover
[ Use inline AutoComplete {outside of Internet Explarer)

| UsE o ELE arer WHern s ] Lol ) a0
IUse Passive FTP (for firewall and D3L modem cormpatibility
se smoath scrolling

|| HTTF 1.1 settings
Use HTTP 1.1
Jse HTTP 1.1 through proxy connections

[~ International*
[i] in

[] Reuse windows for launching shortcuks (when tabbed I:uru:n&]

*Takes effect after vou reskart Internet Explorer

[ Restore advanced settings ]

Reset Internet Explorer setkings

Reseks Internek Explaorer's setkings to their default
condition, =

¥ou should only use this iF vour browser is in an unusable state,

(o] 4 l [ Cancel

Image 8. Advanced Settings for Browsing (IE)

infinitec: Mpus.com

Under the Browsing settings, unmark the Use Inline AutoComplete checkbox.

Java

Set JRE for Java:
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[=7] International* -
[] always show encoded addresses B
Send IDM server names
[] send IDM server names For Intranet addresses
Send UTF-5 URLs

Shows Information Bar for encoded addresses
] - . .

5| Java (3un)

IJse JRE 1.6.0_13 for <applet> {requires restart)

q V] edld
Always use ClearType for HTRL*
Enable automatic image resizing
Play animations in webpages*
[+] Plav sounds in weboages

Image 9. Advanced Settings for Java (IE)

Under the Java (Sun) settings, mark the Use JRE... checkbox.

SSL and SmartScreen Filter

Turn on SSL and the SmartScreen Filter:

[] check Far server certificate revaocation® N
Check Far signatures on downloaded programs D |
[] Do not save encrypred pages ko disk

[] Empty Temporary Internet Files Folder when browser is clo
Enable DOM Starage

Enahle Inteqrated Windows Authentication®

Enahle memary prokection ta help mikigate online atkacks*

[/l Frabla mative % D

Enable SmartScreen Filker
Use 551 2.0

= % H wimtuig

se 55L 3.0

Warn about certificate address mismakch®

~[] Watn f changing between secure and not secure mode
' 1l >

=]

Image 10. Advanced Settings for Security (IE)

Under the Security settings:

1. Enable the SmartScreen Filter to protect against phishing. (This setting was turned off for the
Infinite Campus zone in previous steps, but should otherwise be enabled.)

2. Mark the Use SSL 2.0 and Use SSL 3.0 checkboxes. Infinite Campus utilizes Secure Socket
Layer encryption to protect data as it travels through the web.
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Best Practice — Clear Browsing History

Periodically, Infinite Campus recommends users delete cached browsing files for improved performance
and heightened security. On the General tab:

~
Internet Options 7 PGS Delete Browsing History | = |
i
General | security | Privacy | Content | Connections | Programs | advanced | Preserve Faverites website data
Keep cookies and temporary Internet files that enable your favorite
Home page websites to retain preferences and display faster.
Il l/? To create home page tabs, type each address on its own line, |
L) '3
W httpy/go.microsoft.com/wlink/7Linkid=69157 - Temporary Internet files
A Copies of webpages, images, and media that are saved for faster
- viewing.
Cookies
[ Use current ] [ Use default ] [ Use blay ] Files stored on your computer by websites to save preferences
o d such as login information,
Browsing history
[ History

Sswords List of websites you have visited.

4L \ Delete temparary files, history, cookies, saved
«)  and web form information,

[| Delete browsing history on exit [] Form data

Saved information that you have typed into forms.

Search ™ [7/] Passwords
i”“‘\ Change search defaults. Saved passwords that are automatically filed in when you sign in
4 I to a website you've previously visited.

[ InPrivate Filtering data

Tab:
ans Saved data used by InPrivate Filtering to detect where websites may
Change how webpages are displayed in be automatically sharing details about your visit,
tabs.
Appearance

ing browsing history Delete | | Cancel
e ] ’ Lanquages ] ’ — ] ’ Accessibiity ] About deleting browsing history e ancel

’ Ok ][ Cancel ] Apply

Image 11. Best Practice Clear History (IE)

1. Click the Settings button in the Browsing History section.

Mark (at least) the Temporary Internet Files, Cookies and Passwords checkboxes.
Click Delete.

Also click the Delete button in the Browsing History section.

P

Mozilla Firefox Settings (PC)

For the most recent browser versions that are supported in Campus, see the Supported Platforms article.

The following settings were based off of a Firefox 3.0 configuration. The names of
settings and their locations may vary slightly in other versions.

To protect security, the following browser options should be configured. To access browser settings,
navigate to the Tools menu and select Options.
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infinitecampus.com

Tools | Help

Chrl+

Ctrl+3

Console

Console Ckrl+Shift+1
Info

ivate Data  Crrl+Shifk+Del

Image 12. Tools Menu (Firefox for Windows)

Content Settings

On the Content tab:
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Main Tabs Conkent  Applicakions  Privacy  Security  Advanced

Block pop-up windows

Load images aukomatically

fa 1
ites - Pop-ups .
Bl & allowed Sites - Pop-up x
v
2 You can specify which web sites are allowed to open pop-up wi
the exact address of the site vou want to allow and then click. &
Fonts
Address of web site:
Defau http: jfsupport.infinitecampus. com|
Lanqgu Site Skatus
kraining. infinitecampus. com Bl
hoos )
rail, goodle, com Al
192,168.20,238 Al
192,1658.20,234 Al
192,1658.20,222 Al
192,168.20,210 Al
192,168.20,182 Al
Remove Site ] [ Remove Al Sites ]

Image 13. Content Settings for Pop-Ups (Firefox for Windows)

Pop-up windows must be allowed on the Infinite Campus site in one of the following manners:

® Either the Block Pop-Up Windows checkbox is left unmarked, OR

®* The Block Pop-Up Windows checkbox is marked, but the Infinite Campus site is on the Allowed
Sites list:
® Click the Exceptions button.
® Enter the Infinite Campus site URL in the Address of Web site field.
® Click Allow.
® Click Close.

Privacy Settings

On the Privacy tab:
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ECAMPUSs.Com

J ﬁ '—'L:f_]l % Iiéﬁl f;_

_=

General Tabs Content  Applications | Privacy | Security

1%

r -
[

Advanced

Hiskary

Firefax will: |Use custom setkings For history A |

[] automatically skart FireFox in a private browsing session

Remember my browsing history For at least days

Remember dovnload history
Remember search and form hiskory

Accept cookies From sites

Accept third-party cookies

Keep until: |they Expire v

lzar history when Firefox closes

Location Bar

Show Cookies. ..

Settings for Clearing History

Hiskory
Erowsing Histary
Download Histary

[Data

[] site Preferences

‘“When I quit Firefox, it should automatically cear all:

Cookies
Active Logins

Form & Search Hiskory Cache

OFffline Website
U Data

3

[ ok

l [ Cancel ] [ Help

‘When using the location bar, suggest: |History and Bookmarks

v

Settings...

[ oK ][ Cancel ][ Help

Image 14. Privacy Settings for Private Data (Firefox for Windows)

1. Select Use custom settings for history in the first dropdown list.

Click the Settings button.

Eal S

Passwords.
5. Click OK.

Mark the last checkbox, Clear history when Firefox closes.

Mark (at least) the following checkboxes: Form & Search History, Cookies, Cache, and Saved

nder Tools.

To clear history at any time, select CTRL+Shift+Del or select Clear Recent History u

Security Settings

On the Security tab:
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e
@ X

Passwards Far the Following sites will nok be saved:

Site x
httpsff10,35.60, 12:8030 A r\. KYY.
http: fficpu. infinitecampus . com g == Tl
https i fcpu.infinitecampus ., com: S080 Security  Advanced

http:/fmambo.infinitecampus. com '

Remove Al

Remember passwards Far sites

|:| Ilse a master passwiord

awed Passwords. .. |

@ Saved Passwords

Search: | | 5
Passwiords For the Following sites are stnre olr compuker: e Settings...
Site H=ernarne
hitkp: /ficu.infinitecampus, com -
ik {ficu.infinit user.namel ml

o Micwinfinitecampus . com I —
htkpsffissues,ic.org L=zer.names

' e 4 | fnecel ] [ Help

https: fissues infinitecarmpus . com LIZEMNAme "

Femoyve Al Show Passwiords

Image 15. Security Settings for Passwords (Firefox for Windows)
In the Passwords section:

® Remove the checkmark from the Remember Passwords For Sites checkbox, OR,

® |f passwords should be remembered, mark the Remember Passwords For Sites checkbox but
verify that Infinite Campus sites are on the Exception list:
® Click the Exceptions button.

® Check for Infinite Campus sites on the Exceptions window. If Infinite Campus sites
do not appear:

® Click Close on the Exceptions window.

® Click the Saved Passwords button to see if the usernames/passwords have
already been stored.

Remove saved usernames/passwords for Infinite Campus sites.
® Click Close.
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Advanced Network Settings

On the Advanced tab:

Options

05 s & & & o

Main Tabs Content  Applications  Privacy  Security  Adwanced

izeneral | Mebwark |LI|:u:|ate Encryption

Connection

Configure how Firefox connects to the Internet

COFffline Storage

s up ko L] {:} MERf space For the cache

Tell me when a website asks to skore data for offline use Exceptions...

The following websites have stored data For offline use;

Image 16. Advanced Settings for Connections and Storage (Firefox for Windows)

1. Verify that the network Connection Settings reflect proper district/state setup.

This setting is largely dependent on the distric/state’s specific network
configuration.

2. Click the Clear Now button to clear the network cache.
3. Set the cached MB limit to a low number (e.g., 50 or less).

Mozilla Firefox Settings (Mac)

For the most recent browser versions that are supported in Campus, see the Supported Platforms article.

The names and locations of settings may vary slightly across versions.

To protect security, the following browser options should be configured. To access browser settings,
navigate to the Firefox menu and select the Preferences option:
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irﬁffr'l':t:-_-tjr‘mrnpu 5.COM

File Edit View
t Mozilla Firefox

Preferences...

Services [ ]
Hide Firefox #£H
Hide Others NEH
Show All

Quit Firefox

Image 17. Tools Menu (Firefox for Mac)

Content Settings

On the Content tab:

| — |
O0n0n Content =]

|l| e b pi\i . /ﬁ l;,_ln'f:;;.é

Main Tabs | Content | Applications Privacy Security Advanced

E Block pop-up windows ﬁ m

oo O Allowed Sites - Pop-ups

You can specify which web sites are allowed to open pop-up windows. Type
exact address of the site you want to allow and then click Allow.

Address of web site:

www.infinitecampus.com

Site Status

r
c4creative.arg Allow H (Ad\'HHCEd...>
www.chipotle.com Allow
www.lemonlimestudios.com Allow

(Remmre S'rte) (Remove All S'rtes)

Image 18. Content Settings for Pop-ups (Firefox for Mac)

Pop-up windows must be allowed on the Infinite Campus site in one of the following manners:
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KNOWLEDGE BASE - RECOMMENDED BROWSER SETTINGS

® Either the Block Pop-Up Windows checkbox is left unmarked, OR
® The Block Pop-Up Windows checkbox is marked, but the Infinite Campus site is on the Allowed
Sites list:
® Click the Exceptions button.
® Enter the Infinite Campus site URL in the Address of Web site field.
® Click Allow.
® Exit the window.

Advanced Network Settings

On the Advanced tab:

[ General | Metwork | Update  Encryption 1

Connection

Configure how Firefox connects to the Internet

Offline Storage

Use up to MB bf space for the cache Clear Now

¥ Tell me when a website asks to store data for offline use

Image 19. Advanced Network Settings for Connection and Storage (Firefox for Mac)

1. Verify that the network Connection Settings reflect proper district/state setup.

This setting is largely dependent on the district/state’s specific network
configuration.

2. Click the Clear Now button to clear the network cache.
3. Set the cached MB limit to a low number (e.g., 50 or less).

Privacy Settings

On the Privacy tab:
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aRaXb] Privacy =

Main Tabs Content Applications | Privacy | Security Advanced

History When | ask Firefox to clear my private data, it should erase:

= "] Browsing History
"1 Keep my history for at least 90 . days [ Download History

I!j Remember what | enter in forms and the search barl # Saved Form and Search History

E Remember what I've downloaded - (Download Statushb: ECache

i ECookies
Cookies
1 Offline Website D
"1 Accept cookies from sites ESaved Passwords
" | Accept third-party cookies W Authenticated Ses
- 1 DownThemAll! histhry & queue

Keep until: | close Firefox -

@ C Cancel ) f—ﬁl(—)

Private Data

EAIways clear my private data when | close Firefox ﬁ [ Settings... JI
"1 Ask me before clearing private data

Image 20. Privacy Settings for History and Private Data (Firefox for Mac)

[

. Set the Private Data settings to Always Clear Private Data on browser close.

2. Click Settings.

3. Mark at least the Cache, Cookies, Saved Passwords and Authenticated Sessions checkboxes.
4. Click OK.

Click the Clear Now button at any time.

Security Settings

On the Security Tab:
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MMy M Security =

” @ e [ = ! \ L1l SO0%

= =44 S ] - Eohia
Main Tabs Content Applications Privacy | Security | Advanced

r i

EWam me when sites try to install add-ons | Exceptiuns...\]

@Te!l me if the site I'm visiting is a suspected attack site

@Te!l me if the site I'm visiting is a suspected forgery

Passwords
| | Remember passwords for sites Exceptions...
"1 Use a master password Change Master Password...

_/
L Saved Passwords...

Warning Messages

Choose which warning messages you want to see while browsing the web ( Settings.._x]

® Remove checkmark from the Remember Passwords for Sites checkbox, OR,
® |f passwords should be remembered, mark the Remember Passwords For Sites checkbox but
verify that Infinite Campus sites are on the Exception list:
® Click Exceptions.
® Check for Infinite Campus sites on the Exceptions window. If Infinite Campus sites
do not appear:
® Close the Exceptions window.
® Click the Saved Passwords button to see if the usernames/passwords have
already been stored.
®* Remove saved usernames/passwords for Infinite Campus sites.
® Close the Saved Passwords window.

Safari Settings (Mac)

For the most recent browser versions that are supported in Campus, see the Supported Platforms article.

The names and locations of settings may vary slightly across versions.
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infinitec: Mpus.com

Enabling 32-bit Mode

Infinite Campus recommends operating Safari in 32-bit mode to allow saving of FDF forms in Campus
with Adobe Reader.

(0.0 7 Safari.app Info

= Safari.app
@ Modified: May

Checking this box
allows FDOFs to
save to the
Campus server

¥ General: with Adobe Reader

Kind: Application TIf]
Size: 45.4 ME on f
Where: fApplicatjpfs
Created: Thursd / ay 21, 2009 5:20 PM
Modified: Thu o "" . May 21, 2009 5:20 PM
Wersion Copyright & 2003-2010 Apple Inc.
Labg

E] Open in 32-bit mode

Open using Hosetta

Locked

Image 22. Safari 32-bit Mode

=

Close all open Safari browsers.

Open a new Finder window.

Navigate to the Applications folder.

Select Safari.

Go to the File menu.

Select Get Info.

In the Safari Info window, open the General section.

Select the Open in 32-bit Mode checkbox.

Close the Safari Info window. Upon re-opening Safari, 32-bit mode will be enabled.

©oNoO~WDN

To protect security, the following browser options should be configured on the Safari menu:
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mme Edit View Histor

About Safari
Report Bugs to Apple...

Preferences... 88,
Block Pop-Up Windows {+3K

v Private Browsing

Reset Safari...

Empty Cache... WFEE
Services [ ]
Hide Safari #%H
Hide Others HH
Show All

Quit Safari $0

Image 23. Security Settings for Browsing (Safari)

1. Turn on Private Browsing to erase cookies, auto-fill items and other cached information.
2. Infinite Campus recommends disabling the Block Pop-up Windows setting, so Infinite Campus
pop-ups will be allowed.

In Safari, pop-ups are either allowed or disabled. Unlike other browsers, Safari does
not allow site-by-site control of pop-ups.

Preferences

On the Safari menu (shown in Image 23), select the Preferences option. On the AutoFill tab:

IF 3

OO0 AutoFill (=
Fl 2 ]

A O = Zl & ik

General Appearance Bookmarks Tabs AutoFill | Security Advanced

AutoFill web forms: !‘Z[Using info from my Address Book card [ Edit..

1 Other forms { Edic.. )

Image 24. Preference Settings for AutoFill (Safari)
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Remove the checkmark from the auto-filling Usernames and password checkbox.
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